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ABSTRACT

The rationale ofFinal Year Project (FYP) is to develop student's ability in the process
oflearning and applying knowledge in the area ofinterest with minimum guidance and
supervision. This FYP entitled 'Development ofDeformation Monitoring System ofan
Engineering Structure using Reflectorless Total Station' is basically preparing
appropriate system from hardware and software aspect for deformation of engineering
structure with the aid of reflectorless total station. Deformation ofengineering structure

is measured to ensure that the structure is exhibiting safe deformation behaviour. The

engineering structure selected to assess the workability of the system was the UTP

Academic Complex Canopy. The deformation data collected will be processed and

analysed by developed computer system. The results will demonstrate if movement

occurred on selected structure and give warning when the movement is critical. At the

end if the project is realistic and reasonable, the developed system can be used for

monitoring deformation work of otherengineering structures.
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CHAPTER 1

INTRODUCTION

1.1 BACKGROUND OF STUDY

Engineering structures such as dams, bridges, high-rise structures and oil platforms

are subject to natural causes and to human interaction that may lead to collapse or

structural failure. These structures can undergo deformation due to landslide,

tectonic movement, differences in underground water level tidal phenomena and

many other factors. On the latter circumstance, the development of an appropriate

methodology for the remote structure monitoring is important for safety reasons [4].

Hence, engineering surveying play an important role in determining the magnitude

of movements occurred on structures for the purpose of safety and maintenance. The

measurements techniques can be grouped mainly into two; geodetic and non-

geodetic techniques. The selection of most appropriate technique or combination of

techniques for any particular application will depend upon cost, the accuracy

required, and the scale of the survey involves [8].

In this project, an appropriate deformation monitoring system of an engineering

structure will be developed in order to detect and quantify the deformation if

occurred. The system will consist both software and hardware preparation. The

reflectorless total station chose to measure the coordinates of identified point

because it can be used without reflector. Therefore this instrument can be used for

deformation monitoring of inaccessible structure.

The data from the reflectorless total station will be transferred to computer facilities.

By using relevant software, the computer will automatically interpret if structural

movement detected. Moreover the computer will evaluate whether the movement is



still safe or not. When the movement is exceeding its allowable movement, the alarm

will be automatically triggered as a warning system.

In order to simulate the system developed, an engineering structure which is UTP

Academic Complex Canopy will be monitored to obtain the fieldwork data. The

structure is selected as it is inaccessible structure because it is difficult to put

geodetic target such as prism or GPS receiver due to high constraints. Therefore

reflectorless total stationcan provide the best option for the monitoring work. During

the project, the reflectorless total station is locatedat a permanent locationto observe

the movement of identified reference points on the canopy within certain duration of

time.

1.2 PROBLEM STATEMENT

1.2.1 Problem Identification

The main tasks in deformation monitoring of engineering structure is to study the

magnitude and direction of movement due to factors such as changes of ground

water level, tidal phenomena, tectonic phenomena, and others. The magnitude of

deformation in most common cases is usually small and could not be detected with

naked eyes unless until at the very late stage.

Beside, some structures such as high-rise buildings are allowed to have temporary

movement due to environmental effect like wind and storm. But at the end the

structure will go back to its original position. The structure should be allowed to

move in the range of its allowable movement. For safety purposes, the deformation

monitoring can be used to investigate whether the structure movement is within its

permissible movement. The critical condition occurred when the movement detected

was exceeding its allowable movement.

Mostly the available methods of deformation are costly and time consuming. Hence,

normally involved parties neglect to plan the deformation monitoring work to avoid

cost of implementation. These people assumed that their structures will be stable and

save throughout their design life. But in reality, there are structures that already



collapsed due to deformation failure even tough the structures still in their design

life.

Hence the usage of reflectorless total station in deformation monitoring work can be

applied as it can save time and economical. But the performance of the total station

might become an obstacle to be used for deformation work. The reflectorless total

station may lack the range their counter part with reflector has.

Besides, there were cases of death during structure collapse as people were not

warned or being warned late. There should be a system that can analyze the data

from deformation work and distinguish whether the structure still safe or not.

1.2.2 Significance of the Project

The deformation monitoring is necessary to evaluate the condition of structure. An

appropriate method and high accuracy equipments should be used in order to detect

the deformation at the early phase so that repair work can be done at low cost.

The developments of a system that can provide warning to people are necessary to

save human life. People can get enough time to evacuate the building safely before

the structure collapsing. The system should be able calculating the deformation and

give the output in a short time.

Latest development technology in total station has resulted them could be operated

without reflector (reflectorless total station). Hence its practicality in deformation

monitoring has significantly improved. This is due to the fact that now it could be

used in any structure that was before inaccessible because of reflector placement

difficulty.



1.3 OBJECTIVES AND SCOPE OF STUDY

1.3.1 The Relevancy of the Project

As the author had identified the current problem, the author was thinking of

developing the application that can overcome these problems. The desired product

would be deformation monitoring system of engineering structure with the aid of

reflectorless total station. Basically, there are two objectives for this project which

are:

a) To develop a system that warns the users when the deformation of selected

engineering structure is critical.

The main objective of this project is to develop a system that can analyze the

data obtained from reflectorless total station. The system will quantify the

magnitude of deformation and give output; if the deformation is critical, an

alarm will be triggered automatically. The system also will store the data

inserted for future reference. The real data are taken in order to test the

system.

b) To assess the performance of reflectorless total station for deformation

monitoring inaccessible structure.

Currently the conventional total station was using for most of surveying work

including deformation monitoring of structure. As technology advances,

reflectorless total station had been designed. This equipment can measure

object without using reflector. However the real performance of the

equipment is uncertain. It is important to evaluate its performance during

monitoring work of selected engineering structure.



1.3.2 Feasibility of the Project within the Scope and Time Frame

The feasibility of this project is to develop deformation monitoring system with the

aid of reflectorless total station. The analysis is done by developing a system that can

detect deformation on selected structure. It took about two semesters to accomplish

the project. In the first semesters, the author just concentrated on literature review

and research towards the implementation of application. Then for the second

semester, the author is applying the theories gained and develops a system using

Microsoft Visual Basic 6.0. The data obtained from observing UTP Academic

Complex Canopy with the using of reflectorless total station is used to test the

functionality of developed system.



CHAPTER 2

THEORY

2.1 DEFORMATION OF ENGINEERING STRUCTURES

In engineering mechanics, deformation is a change in shape of an object because of

an applied force. This can be a result of tensile forces, compressive forces, shear,

bending or torsion. In Figure 2.1 below, it can be seen that the cylinder had exhibited

deformation due to compressive loading (indicated by the arrow). The sides bulge

because the material, although strong enough to not crack or otherwise fail, is not

strong enough to support the load without change, thus the material is forced out

laterally. [7]

•* ~ _ •-

• i

• i

• i

• i

Figure 2.1: Deformation of cylinder

Engineering structures are subject to, deformation due to factors such as changes of

ground water level, tidal phenomena, tectonic phenomena, and others. Engineering

structures are designed and constructed to meet the requirements of a particular

project. These structures differ in size, shape, and intended function between

projects. As a result, the magnitude of differential settlement and movement that can

be tolerated must be established for each structure. Specifications for the allowable

magnitudes of differential deformation that can be tolerated are determined by

structural and geotechnical engineers. The magnitude of allowable differential



movement shouldbe sufficiently low to prevent the development of shear and tensile

stresses within the structure in excess of tolerable limits.

The collapse of Highland Tower building, the Sultan Abdul Halim ferry terminal

bridge collapse, Hotel New World disaster, Sampoong Department Store collapse,

were the structural failure disasters that occurred due to deformation problems. In

order to evade such incidents from happening over again, the need to determine the

suitable technique and instrument that applicable to detect and monitor deformation

is very important. Deformation measurement techniques generally can be divided

into geodetic and non-geodetic methods.

Each main measurement technique has its own advantages and limitations. Geodetic

techniques by angle or distance measurements provide an adequate redundancy of

observations for the statistical evaluation of their quality and for a detection of

errors. They give global information on the behavior of the deformable structure

while the non-geodetic techniques give localized and locally disturbed information

without any further check. Besides, the instruments used in non-geodetic

measurements, are easier to be used for automatic and continuous monitoring than

conventional instruments of geodetic measurements. Geodetic techniques have

traditionally been used for determining the absolute displacements of selected points

on the surfaceof the object with respect to some referencepoints that are assumed to

be stable. Non-geodetic techniques have mainly been used for relative deformation

measurements within the deformable object and its surroundings. [6]

2.2 THE GEODETIC METHODS

The geodetic methodsthat normallycan be used are Global Positioning System

(GPS), close rangephotogrammetry and conventional terrestrial survey.

GPS offers advantages over conventional global methods. Intervisibility between

stations is not strictly necessary, allowing greater flexibility in the selection of

station locations. Measurements can be carried out during night or day, under

varying weather conditions. The limitation using GPS is the location of the GPS



receiver should be at open space and clear sky in order to have better and clear

signal.

Close range photogrammetry defines as if an object is photographed from two or

more survey points of known relative positions with a known relative orientation of

the cameras. Thus, relative positions of any identifiable object points can be

determined from the geometrical relationship between the intersecting optical rays

which connect the image and object points.

Conventional terrestrial survey normally interested in determining precise levelling

measurements, angle and distance measurements. The use of level, theodolite, and

total station are needed during conducting this method. The use of prism (geodetic

target) is needed as reflector in order to obtain the measurements. This method is

considered as more economical but the placement of reflectors normally consuming

time.

Magnitude of deformation in geodetic methods can be calculated by finding the

difference of original coordinates and current coordinates.

(Ax,Ay,Az)-i(x,y,z)-(x',y',z')|

The total displacement of the structures can be obtained from root mean square

equation.

Total displacement, d= -J(Ax2, Ay2, Az2)

The structure is considered in critical when the total displacement calculated higher

than the structure's allowable tolerance.



2.3 INSTRUMENT UTILIZED

2.3.1 Reflectorless Total Station

Some recently introduced total station can measure deformation without using

reflector which the measuring surface itself is used as a reflector. Some

manufacturers employ a timed-pulse infrared signal, transmitted by a laser diode.

This reflectorless total station permits direct acquisition of distances from target. It

can be usedpromisingly at the places where the problem to locate prism arise due to

steep slope, hazardous area and inaccessible building. The reflectorless total station

has been used in improving speed and accuracy alongwith low maintenance and less

cost as compared to more conventional survey methods. Besides, it can be handled

by saving workforce.

When the first short-range EDMs (Electronic Distance Measuring) were introduced

in the late '60s, it changed forever the way distances are measured [6]. Reflectorless

total station is used with an attached EDM beam which helps to identify the feature

being measured; that is, the visible beam is set on the desired feature so that the

correct surface is being measured and not some feature just beside it or just behind it.

Since the measurement is so fast, care must be taken not to mistakenly measure to

some object that may temporarily intersect the measuring signal.

The problem that always arises with reflectorless total station is coming from its

large EDM beam spot that result the reflectorless total station is not capable to

measure small objects. The other problem is the reflectorless total station does not

give the accurate distance during measurement. Sometimes actual measurable

distance drops down into very short only. The reflectorless total stationperformance

is influenced by colour, shape and surface of the measured object.

Thus, in order to improve the problem faced while using reflectorless total station,

some manufacturer like Topcon Corporation has come out with its reflectorless total

station which is reliable because it will only provide the accurate result. The

reflectorless total station will not give value at situation which is difficult to measure

(such as building corner and chainlink fence). The total station also provided with



precise pulse-laser system which can rectify the problem while measured small

objects. In addition, the reflectorless total station provides the longest reflectorless

range (up to250 m) that only uses safety class 1laser which is not harmful tohuman

health.

The Topcon's reflectorless total station also equipped with dual laser optics system.

One narrow beam can be usedfor non-prism mode and a broader beamwhen prism

mode is chosen. This stabilizes the beam over long distances by providing accurate

measurement even in adverse atmospheric conditions suchas heatshimmer [3]. The

reflectorless total station used for this project is GPT3005LN (or for international

level known as GPT3005LW). The product specification is attached in Appendix A.

Figure 2.2: Topcon'sreflectorless total station

2.4 SOFTWARE UTILIZED

2.4.1 Microsoft Visual Basic 6.0

The Visual part refers to the method used to create the graphical user interfece

(GUI). Rather than writing numerous lines of code to describe the appearance and

location of interface elements, prebuilt objects canbe added intoplace on screen.

The Basic part refers to the BASIC (Beginners Ail-Purpose Symbolic Instruction

Code) language, a language used by more programmers than any other language in

10



the history of computing. The new users can create useful applications by learning

just a few of the keywords whereas the power of the language allows professionals

to accomplish anything that can be accomplished using other programming

languages.

The features that Visual Basic has:

• Data access features allow user to create databases, front-end applications,

and scalable server-side components for most popular database formats.

• ActiveX technologies allow user to use the functionality provided by other

applications, such as Microsoft Word processor, Microsoft Excel

spreadsheet, and other Windows applications.

• User's finished application is a true .exe file that uses a Visual Basic Virtual

Machine that user can freely distribute.

Figure 2.3: Microsoft Visual Basic 6.0 interface

2.4.2 Microsoft Access

Microsoft Access is a popular program used to create and manage databases. It is

provided with built in features to assist in developing and viewing information.

11



It is important to understand how Microsoft Access breaks down a database. Some

terms involved in this process are: Database File, Table, Record, Field, and Data

type. Below is the Hierarchy that Microsoft Access uses in breaking down a

database.

Database File

'r

Table

' '

Field

i '

Data-type

i '

Value

Figure 2.4: Hierarchy of databases' break down in Microsoft Access

Database File is the main file that included the entire database and that is saved to

computer storage. A table is the collection of data about a particular topic. Fields are

the different groups within a table. Table commonly encloses several fields. Data

types are the properties of each field. A field must only have one data-type.

2.4.3 Topcon Link

Topcon Link developed by Topcon Company is a computer program that transfers

files from and to any Topcon data collector, Topcon total station and Topcon GPS

system to a PC. The software can view, edit and convert coordinate and raw data

files and distinguishes many standard formats.

The use of the software can help to save time used when transferring data taken.

Besides it can reduce human errors during importing and exporting files.

12



3 fto Bft Wh

amiNatMw! amdEaani BmmniCoaj

iz.«5

-3.TO

-I3.KI

hood

o,o»

5.9L7

20.87&

9,009 Ml

s.raj cej

IfffotMn . NmB

Figure 2.5: Topcon Link interface

The data transferred to PC will be saved as text file. The format of data in the text

file showed as Figure 2.6 below.

<Point numrjer>,<Northing>,<Easting>,<Elevation>,<Data label>

Figure 2.6: Coordinate data format in text file
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CHAPTER 3

METHODOLOGY/PROJECT WORK

3.1 PROCEDURE IDENTIFICATION

For this part the basic experimental set up and instrumentation will be explained.

Basically after research work was done, the next project progress is divided into

three phases which is as in Figure 3.1 below. The first phase is began with site and

equipment preparation and followed by second phase which is system development

phase. The final phase is experimental works.

Phase 1

Site Selection and Equipments
Preparation

i T

Phase 2

System Development

i '

Phase 3

Experiments

Figure 3.1: The project's phases
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3.1.1 Phase 1: Site Selection and Equipments Preparation

3.1.1.1 Identify and determine possible control point locations

Control point acts as the fixed point whereby the monitoring data are

collected from time to time. One control point identified as observation point

is located on engineering structure which is on the top of building 14andwill

be the place to put the reflectorless total station.

The reason why the author chooses to locate the mounting pod on this

structure is because it is the best location with minimum distraction. The

location is not the place where peoples always access. Thus, the risk that the

mounting podhad beenremoved and disturbed is small. Besides, the place is

not imposed to environment change like rain. Therefore even during bad

weather, the data collection work still can be conducted.

Figure 3.2: Observation point

Reference point is used as reference to other control points. The reference

point acts as the pointof calibration to eliminate the error during monitoring

observation points. Both observation point and reference point needed to be

15



rigid and not exhibit any deformation so that no error detected during

fieldwork.

Figure3.3: Reference point

Selection ofControl Points for Deformation MonitoringSystem

During the fieldwork, the deformation of two observed points namely

Observed Point 1 and Observed Point 2 located on UTP Academic Building

Canopy around Civil Engineering Buildings (Block 13 and Block 14) were

observed. These two points will beobserved daily for certain duration oftime

to obtain continuous data.

16



Figure 3.4: Observed Point 1

Figure 3.5: Observed Point 2

The important features that taken into considerations while choosing the

location of the control points are:

• The control points located on the canopy should be assessable from

the observation point,

• The observation points and the reference point should not exhibit any

deformation.

17



• The location of these control points does not obstruct the continual

activities around them.

Selection ofControl Points to Assess the Reflectorless Total Station

In order to asses the reflectorless total station performance four groups of

point are selected namely Points A, Points B, Points C and Points D. These

points located at different location and distance. Each set of these points

consist of two individual points which both located vertically to each other

(refer toAppendix B). The vertical distance ofthese two individual points are

same throughout the four groups of point. The reflectorless total station will

measure the upper point and then measure the bottom point. The vertical

difference will be obtained by subtracting the upper point elevation with

lower point elevation. Supposedly the vertical difference of the four groups

ofpoint should be the same. Thus, from the experiment the performance of

reflectorless total station when measuring variation of distance can be

evaluated.

Figure 3.6: How vertical difference obtained

18



3.1.1.2 Design of Reflectorless Total Station Mounting Pod

In order to make sure the observation point does not change during data

collection the author is required to design a mounting pod for the

reflectorless total station. The mounting pod will be located at the

observation point throughout the project so that the inaccuracy because of

human contact is minimized.

Figure 3.7: Reflectorless total station's mounting pod

19



Steelpkts

141X101

ftnglebar

1200 mm

Steel plate

*•

600 mm

Figure 3.8: Reflectorless total station's mountingpod dimension

The design of mounting pod is as Figure 3.8 above. The mounting pod is

made of steel so that it can be constructed in short time. Beside, the heavy

weight of the steel itself can forbid the mounting pod from easily moved.

The total height of the mounting pod is 1214 mm. The area of basement plate

is 600 mm x 600 mm while the top plate area is 200 mm x 200 mm. the

screw with diameter of 16 mm is installed on centre of top plate in order to

hold the reflectorless total station from moving.

20



3.1.2 Phase 2: System Development

Requirements
Analysis

Preliminary
Information

Gathering

Programming
Phase

Testing and
Debugging

Figure 3.9: Sub-phases in system development

3.1.2.1 Requirements Analysis

At this initial phase, various issues are being discussed hence detennining the

objectives of the project. Understanding the objectives of the project is very

significant as to guide the author to the correct path and to accomplish the

project within the predefined scope. Discussion with supervisor is helpful to

clearly define the objectives and scope of the project. Although requirements

might be changed from time to time, analysis for each requirement can

determine whether the requirements are feasible or not. If it is not feasible,

the requirement can be ignored and the author can proceed with feasible

requirement only to save the time. Requirements analysis are important such

that to make sure no requirement is being left out or neglected at the end of

the project. At the end of this phase, the author already has clear and distinct

requirements of the project.

In this phase, the author has made decision on the software to be used in

development phase. The systemwill be developedby using Visual Basic 6.0.

As it name implies, Visual Basic is more visuallyorientedthan most ofother

programming languages. In fact, Visual Basic represents a new way to write

21



computer programs. Within the last ten years, Visual Basic has become one

of the most popular languages for developing industry and enterprise

applications. In large part, the success of Visual Basic is due to its ability to

hidetechnical complexity and allowdevelopers to focus on the big picture.

3.1.2.2 Preliminary Information Gathering

Then, the development work starts with preliminary information gathering

whereby a lot of researches have to be done by collecting materials from

library and Internet. The research is very important so that the author can

have better understanding about the implementation of the system. As the

authordoes not have much understanding towards the programming language

to be used (Visual Basic 6.0), the author needs to study that language in

detail before the programming phase. As such, the result would be a

benchmark towardsthe development of the applicationlater on.

3.1.2.3 Programming Phase

This is the main phase in System Development phase. During programming

phase, themain taskis to develop deformation monitoring system which can

evaluate and store data that had been transferred. The system can notify user

when criticaldeformation is detected. The warningsystem work is illustrated

as in Figure 3.10 next page.
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HOW THE DEFORMATION

MONITORING SYSTEM WORK

Insert the original coordinates
(x,y,z) and allowable

movement (d)

Obtain current coordinates

from text files

T
Determine the individual movement

(Ax,Ay, Az)= (x,y,z)- (x'.y'.z')

Determine the total movement, d'

The structure is safe

The structure is in

danger and the alarm
will be triggered

Figure3.10: Flowchartof deformation monitoring system

First, the system is designed to ask the user to insert the original coordinates

(x,y,z) of point and its allowable movement (d). Then the system is

developed to obtain the current coordinates (x',y',z') from text files. The

system will determine the individual movement (Ax, Ay, Az) by finding the

difference between latest coordinate with original coordinate. From the

indivual movement, the system will deterrnine the total movement (d') by

using root mean square equation. The system will check if the observed

movement (d') is exceeding the allowable movement (d) or not. If the

movement is lower than its allowable movement, the structure is considered

in safe condition. But if the movement is higher than its allowable

23



movement, the structure is in danger state and the alarm will be triggered so

that peoplecan evacuate immediately from the structure.

3.1.3 Phase 3: Experiments

The arrangement ofthe experimental set up is summarized in Figure3.10

below.

Computer
Facilities

Reflectorless

Total Station

Observed

Point

<x,y,z)

Reference

Point

UTP Academic

Canopy

Figure 3.11: Data collection layout

The reflectorless total station will be mounted on the mounting pod which is

located at observation point. The reflectorless total stationneed to be set up

accordingly to reduce error (The procedure to setup the total station and

preparing data collector are attached in Appendix C).

Firstly the reference point will be assessed and identified. Then the observed

points will be monitored to obtain their coordinates (x,y,z) based on their

lengthfrom established referencepoint.

The data collected will be transferred to computer facilities via direct

connection using transfer cable. A program namely Topcon Link used to
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enable the transfer process to be established. The procedure to use Topcon

Link is attached in Appendix D. A text file which is filel.txt will be

generated in computer storage once the transferring process finish.

The data inside ike filel.txt will be uploaded automatically by Computer

Deformation Monitoring System developed using Visual Basic 6.0. The

system then will analyze the data to distinguish whether the structure is still

safe or not.

In order to store the data in proper way, Microsoft Access program is linked

with the deformation monitoring system. Beside Microsoft Access can be

used to develop graph in order to study the trend ofdeformation.

3.2 TOOLS OR EQUIPMENTS REQUIRED

Figure 3.12: Equipments set up
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To ensure the expected application to be run smoothly, the author needs several

related equipments (hardware and software). Below is the list of related tools or

equipment required:

3.2.1 Hardware

a. Reflectorless totalstation with transfer cable

The reflectoless total station used to quantify the magnitude of deformation

during monitoring work. The transfer cable needed to connect the

reflectorless total station with computer facilities. This equipment is

borrowed from supplier.

b. Reflectorless totalstation mountingpod

The mounting pod is the equipment to cater a place for reflectorless total

station to be located. This equipment is located at permanent location to

reduce the error because of equipment movement.

c. Computerfacilities

In order to evaluate the deformation work, the computer facilities needed to

run the application.

3.2.2 Software

a. Microsoft VisualBasic 6.0

To develop the deformation monitoring system, the author chose to develop

it using this software as it is powerful and user friendlyapplication.

b. Topcon Link

This software used to transfer files from reflectorless total station to PC. The

data file which will be in text filewill be usedby the deformation monitoring

system to be analyzed.
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c. Microsoft Access

This program used to create and manage databases. The program will be

linked with Visual Basic application in order to store the data from

deformation work.
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CHAPTER 4

RESULTS AND DISCUSSION

4.1. RESULT

4.1.1 System Interface

Mi

Fte Run Help

Date:

m/d/yyyy

DEFORMATION MONITORING OF ACADEMIC

COMPLEX CANOPY

Original Coordinate (m)

V: j

Z:i '
Allowable Movement (m):

Coordinate taken (nt):

X V Z

Coordinate difference (m):

X Y Z

HUH

Figure 4.1: The system interface
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4.1.2 Deformation Monitoring Experiment

Table 4.1: Coordinates ofobserved points in Microsoft Excel

Observed Poinit1<m) Observed Point 2 (m)

Date X y z X y z

*23-Feb 21.217 5.917 9.008 -3.993 20.878 7.414

24-Feb 21.215 5.918 9.006 -3.991 20.881 7.414

25-Feb 21.216 5.920 9.004 -3.992 20.881 7.415

26-Feb 21.214 5.920 9.006 -3.994 20.882 7.421

27-Feb 21.215 5.918 9.011 -3.992 20.881 7.419

28-Feb 21.215 5.920 9.008 -3.998 20.879 7.420

1-Mar 21.231 5.859 9.009 -3.935 20.895 7.413

2-Mar 21.221 5.917 8.991 -3.993 20.880 7.420

3-Mar 21.222 5.916 8.989 -3.992 20.875 7.442

4-Mar 21221 5.917 8.996 -3.990 20.884 7.414

5-Mar 21.220 5.911 9.004 -3.989 20.883 7.409

* The coordinate obtained on 23 February is assumed as initial coordinates

and the coordinates obtained in text file format attached in Appendix E. The

allowable movement is assumed to be 0.03m

i^assssiffia ^"^-^"^fiBiflJii [artii'"i™ESiffiS3SE

'•Tt&LPffn : Table ' "-J'H'A

fld date ~] fid x | fld_y j Wz | fld dffif j flddifly T fldjfflfe | ftd distance [ ffdjesuft
2/24/2006 21.215: 5.918 9.006 0.002; 0.001 0.002 0.003; OK

2/25/2006 21.216: 5.92 9.D04 0.001! 0.003 0.004 0.035 OK

2/26/2006 21.214: 5.92 9.006 0.003 0.003 0.002 0.005 OK

2/27/2006 21.215 5.913 9.011 0.002: 0.001 0.003 0.004 OK

2/28/2006 21.215: 5.92 9.GQ8 0.002, 0.003 0 0.004 OK

3/1/2006 21.23V 5.S59. 9.009 0.0141 0.G58 0.001 Q.O&DMGER!

J 3/2/2006 21.221: 5.917' 8.991 0.004; 0 0.017 0.017 OKJ
a/3/2006 21.222' 5.916 8.989 0.005' 0.001 0.019 0.02 OK

3/4/2006 21.221 5.917 8.996 0.004' 0 0.012 0.013 OK

"*
3/5/2006 21.22 5.911. 9.004 0.003. 0.006 0.004 0.008 OK

ftBcordiyuLUl 7 \M£M rf «> =MwrasmmmTS=B„„,.,„••„-, •„„••„•,,

Figure 4.2: The deformation result for Observed Point 1
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in KSt]MMEl39

fld~M T fldj j

,-:r^--,..>-,.-.;-•-=-->—,;-•-^-^.-—•>,_•.•-• --.•.,••••,,,. """'^'n%

fld date P •rrr^nM j.hiannttTi^?«aiMTr?^gTraTT?BBrrBr!^M

2724/2006: -3.991 20.881: 7.414; 0-002I D.003! 0. OJ304'OK ,

25500061 -3.992, 20.881 7.41& Q.0D1: 0.003 0.001 0.003 OK

2/26/2Q06; -3.994' 20.882 7.421: 0.001 0.004 0.007 O.G08!OK

2Q7/2Q06 -3.992 20.881 7.419 0.001; 0.G93 0.005 0.006 OK

228/2006 -3.998 20.679 7.42 0.005, 0.001' 0.006. 0.008 OK

3/1/2006: •3.935 20.895 7.413 0.058: 0.017i 0.001 0.06 DANGER!

3/2/2006 -3.993 20.88 7.42' 0; 0.002' Q.006: 0.006; OK

302006: -3.992 20.875 7.442 0.001 0.003 0.028: 0.028: OK

3/4/2G06 -3.99 20.884 7.414 0.003. 0.006 0' 0.007 OK

•

3/5/200S: -3.989: 20.883,

of it

7409 0004 0.005 0.005 0.008' OK
'"= " '""" " " ""j.: ""

ReflntUULUI " )M\

Figure 4.3: The deformation result forObserved Point 2

4.13 Reflectorless Total Station Performance Experiment

Table 4.2: Different in verticaldepthsbetweenfour points

AverageHorizontal

Distance (m)

Different in

Vertical Depth (m)

Points A 18.745 0.497

Points B 23.957 0.493

Points C 166.131 0.511

Points D 223.810 0.516
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42 DISCUSSION

4.2.1 System Interface

The objective of the system is to run the analysis for deformation monitoring of

academic complex canopy. The program will acquire the required data to be keyed-

in into the systemto perform the analysis. Generally, the screenshots of the system

are as follow:

Welcome

•
v:"trx

DEFORMATION MONITORING OF

AGADEMIC COMPLEX CANOPY

Choose which point of interest you want
to analyze :

OBI

0B2

Figure 4.4: Main page ofthe system

First of all, the main page of the system will be displayed as shown in the above

figure. The user needs to choose which observationpoint to analyze; either OBI or

OB2.
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Ffe Run

Date:

m/d/yyyy

J2/24/200G '"

DEFORMATION MONITORING OF ACADEMIC

COMPLEX CANOPY

Original Coordinate (m)

V : 15.917

z: iaooe
Allowable Movement (m):

|b.03

Coordinate taken (m) :

X V 2

Coordinate difference (m):

X V 2

Iaooe jaodT \qMT21.215 5.318

HON

£

Figure 4.5: The system layout

Movement

Distance
(m): Result

0.003 jOK

In this system, the user needs to fill in several parts which are (as indicated in the

above figure):

1) Reference coordinate for x, y, and z (in meter, m)

2) Allowable movement (in meter, m)

For item no 1 and 2, the default value is displayed as shown in the screenshot above.

However, the user can change the value as and when needed. To add new data, the

user needs to click on File > New (as shown below).

Figure 4.6: File > New menu

For item no 3, the date will be automatically appear based on current date. Then, the

user need to load coordinate taken from the text file by clicking File > Load (as

shown next page).
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:f£te Run Help

New

Load

Reset

Backto MainPage

Exit

Figure 4.7: File > Load menu

The "Load" function will load coordinate taken for x, y and z in item no 4 from the

text file and basedon the observationpoint that has been chosen. The text file will be

generated from the Topcon Link software which is obtained from reflectorless total

station. After that, the user needs to run the analysis by clicking on Run > Analyze.

Figure 4.8: Run > Analyze menu

The analysis will be performed based on the pseudocode below:

1) Finding the difference between the coordinate taken and the reference

coordinate for x, y, and z. The result will be put in the textbox of coordinate

difference for x, y and z.

2) Finding the total movementdistance by usingroot mean squaremethod.

3) Comparing the total movement and allowable movement. The message box

will appear to notify the result of the analysis. The result will be put in the

textbox for Result.

4) Produce sound as an alert if maximum different is greater than allowable

movement (DANGER!!).

If the user wants to add data for other observed point, the user needs to click on File

> Back to Main Page. The main page will appear as Figure 4.4 in previous page.
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pge! Run Help

New

Load

Reset

Bade to Man Page
Exit

Figure 4.9: File > Back to Main Page menu

The other functionality of this system is that it will store all the data in the database

(.mdb files in Microsoft Access) after the analysis is performed. Thus, the data can

be reviewed for future reference. The user needs to click on the Adodc control in the

system to view the available data (as shown in the figure below).

First record / \ Last record

Previous record Next record

Figure 4.10: The Adodc control

hHIHh

After performing the analysis, the result will be shown in the message box as follows

(an alarm will be triggered on the same time ifthe result is danger):

Result

Figure 4.11: Result's message box

As in the File menu ofthe system, there are five submenus which are 'New', 'Load',

'Reset', 'Back to Main Page', and 'Exit'. The 'Reset' submenu will clear the textbox

whereas the 'Exit' submenu is to quit from the system. If the user clicks on the 'Exit'

button, the message box will appear asking confirmation from the user if they really

want to quit from the system.
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Attention

Are you sure want to exit?

Yes No

Figure 4.12: Exit submenu's message box

The coding of the system is attached in Appendix F. The system developed can be

used to other computer without needing to install Visual Basic 6.0. This can increase

the usefulness of the program to otherdeformation monitoring work.

4.2.2 Deformation Monitoring System Experiment

A fieldwork was done to obtain two points of interest (POI) coordinate with time

varied in order to test the deformation monitoring system. The data taken was in

daily basis (from 23 February 2006 to 5 March 2006). The coordinate obtained on

day first was assumed to be the initial coordinate while the data taken for the next 10

days were assumed as current coordinates.

The allowable movement was assumed to be 0.03m as the actual allowable

movement is unknown. The system performed well when the analysis done; alarm

was triggered when the movement higher than actual movement. The status of

deformation of these observed points can be obtained in the column 9 in Figure 4.2

and Figure 4.3 which each figure show only one danger result (1 March 2006). The

individual deformation can be obtained in column 5 until column 7 and movement in

three axes direction can be obtained in column 8.

The graphs of the movement in single axis versus time and the graph of the three

axes movement versus time for each observed point are plotted to investigate the

result.

Figure 4.13 show the movement in single axis versus time for Observed Point 1

(OBI). It can be noticed that during 1 March 2006the fluctuation occurred in y-axis
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which about 0.058m. Other data were still stable and not showing much different

with each other.

c

0.07

0.06

0.05

0.04

0.03

0.02

0.01

0

Movement in Single Axis vs. Time for OB1

2/24 2/25 2/26 2/27 2/28 3/1 3S 3/3 3/4 3/5

Time (date)

Figure 4.13: Movement in single axis against time for OBI

From Figure 4.14 show that movement ofObserved Point 1 in three axes direction. It

shows that the fluctuation still occurred on 1 March 2006. This because the data had

been influenced by the measurement obtains from y-axis movement.

0.07

§ 0.06

| 0.05

| 0.04
H

.E 0.03

I 0-02
I 0.01

0

Movement in Three Axes vs. Time for OB1

2/24 2/25 2/26 2/27 2/28 3/1 3/2 3/3 3/4 3/5

Time (date)

Figure4.14: Movement in three axes against time for OBI

Meanwhile Figure 4.15 showsthe movement in single axis versus time for Observed

Point 2. From the plotted graph, it shows that on 1 March 2006 the maximum
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measurement detected. The reading comes from x-axis value which was 0.058m.

Others value were quite stabile with the magnitude below 0.028m.

0.07

& 0.06
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c

35
c

0.05
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0.03

0.02

0.01

0

Movement in Single Axis vs. Time for OB2

2/24 2/25 2/26 2/27 2/28 3/1

Time (date)

-♦-x-axis

-*— y-axis

z-axis

3/2 3/3 3/4 3/5

Figure 4.15: Movement in single axis against time for OB2

As the result of maximum value of x-axis on 1 March 2006, the movement on that

day was also the highest one. From Figure 4.16 the maximum movement in three

axes direction is 0.06m.

0.07

i- 0.06

83 0.05

J 0.04
y-

£ 0.03

c

I 002
| 0.01

0

Movement in Three Axes vs. Time for OB2

2/24 2/25 2/26 2/27 2/28 3/1

Time (date)

3/2 3/3 3/4

Figure 4.16: Movement in three axes against time for OB2
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The coordinates values obtained are quite acceptable for these two observed points

which can simulate the best deformation scenario of the selected points except for

value obtained on 1 March 2006. It is not reasonable that the movement can be as

big like that even tough high rise structure had been permitted to have certain

tolerable movement due to environmental fectors. Thus, some errors had been

occurred while observation works were done.

The error occurred mainly because the observed points are not small to be observed

as the both of points actuallyare bolts located on UTP Academic Complex Canopy.

The reason the author choose the bolts as observed point because they are the only

components that can be identified located on the canopy as the monitoring work

would be done on daily basis. Thus it is reasonable to choose the bolts because they

are easily to be recognized.

Point of

intersection

Bolt

^^ Nuts

Figure 4.17: The expected intersection point on bolt

Suppose the author need to observe the centre of bolt during obtaining the

measurement. The author might be not measuring the centre of bolt during the error

measurement taken. This type of error can occur often as the intersectionpoint in the

reflectorless total station is very small and precise and the observed point is quite

big.

Besides, it is hard to get the right angle during observing the point through the total

station. The point of intersection inside the total station was hard to locate so that it

is aligned with the point of interest when reading it from wrong angle. The third

constraint is total station's point of intersection is hard to be traced when the point of

interest is directly exposed to sunshine. The author needs to observe carefully the
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location of intersection point in the reflectorless total station as the intersection point

will become smudge during this condition.

4.2.3 Reflectorless Total Station Performance Experiment

Vertical Depth Different vs Average
Horizontal Distance

0.9

3 0.8
"£ 0.7
2*0.6
°|0.5
O « 0.4

i 0.3
5 0.2

0.1

50 100 150 200

Average Horizontal Distance (m)

250

Figure 4.18: Vertical depths different against average horizontal distance

This experiment was conducted after the deformation monitoring work was done.

The vertical depth difference obtained by subtracting two points that different in

height but located at the same horizontal distance. Supposedly this experiment

should be conducted at initial phase in order to evaluate the performance of

reflectorless total station before fieldwork start. But as refer to the graph above, the

measurement of these four points are consistent which show the reflectorless total

station still performs when the distance of object increased. It is verifying the claim

by manufacturer that the total station can give precise measurement up to 250m.
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CHAPTER 5

CONCLUSION AND RECOMMENDATION

5.1 RELEVANCY TO THE OBJECTIVES

The whole project is intended to develop a system during deformation monitoring

work. The development of a warning system will enhance the deformation

monitoring work to be more effective. People can be warn immediately when the

structures is no longer safe. This system can help saving humans life if installed at

each structure. The system performed well during tested with actual fieldwork data.

The magnitude of deformation of selected structure which is UTP Academic

Complex Canopy is considered in safe behavior. Suppose the movement occurred

are not permanent deformation but only the temporary deformation which any high

structure should have. Besides, the error which came from the author while using

reflectorless total station was influencing the result. The reflectorless total station is

powerful tool to be used in monitoring work but certain precautions should be

considered if this instrument is going to be used.

5.2 FUTURE WORK

There is plenty of room in this project for upcoming work. The development of

system which can provide a real time monitoring work needed. The author initially

actually tried to develop a system which can connect with reflectorless total station

so that the data from the reflectorless total station can be automatically transferred

from reflectorless total station into the system to be analyze immediately. But the

author unable to further more due to certain circumstance such as limited

information on how reflectorless total station functioning during data transferring.

Besides, the complicated programming language and installation of additional

electronic instruments might be needed to realism this work. Thus, collaboration

with IT expert may become worth.
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It is encouraged if the reflectorless total station can measured the point by its own.

The total station is set up to take reading in certain duration. Thus the usage of

human power can be reduced. The errors that also come from human also can be

minimal as the total station can measure the point automatically. Unfortunately the

current total station is not enabled to do this type of job. The usage of highly

Artificial Intelligent total station which called robotic total station is known can

automatically take themeasurement without involvement from human being.

Plans for future work also include how accurately theposition of observed points can

be defined. As the reflectorless total station can measure all the objects and give the

output, thus the users need to evaluate the points which can be measured precisely.

Several precautions need to be developed during monitoring points so that the point

measured is the correct point and not the adjacent location.

Besides certain experiments need to be conducted in order to evaluate the

performance of reflectorless total station. It can be done by comparing the

measurement of an object taken by reflectorless total station and conventional total

station. Ifboth the measurements are the same, the reflectorless total station ability is

experimental approved and should beuse for other monitoring works. Unfortunately

during the project, the author was unable to conduct the experiment because lack of

times and more concentrating on development of computer system rather than

evaluating the reflectorless total stationcautiously.
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Appendix A: The Reflectorless Total Station Specifications

LONGEST REFLECTORLESS RANGE

Topeon's unique pulse lasertechnology allows theSPT-3000
series to measure up to 250m in the sfindaid reflectorless mode,

and now up toanastonishing 1200m inthe newLongRange
mode! Topcon has developed thisadvanced technology to grve
youthe best reflectorless performance with complete safety and
confidence. The Class 1 laser is safe to usearound populated

areas of heavy traffic.

The new Topcon SOOOUrV series measures nearly foil times fenher
thanany othercompetitive totalstation, onceagain demonstrating
the technology advantages thatTopcon offers.

• UAL LASER OPTICS

Topeon's GFT-3000 usesa dual laser optics system, one narrow
beam for non-prism functions, anda broader beam when using a
prism. This stabilizes the beam over long distances providing
accurate measurement, even inadverce atmospheric conditions

such as heat shimmer.

BLUETOOTH WIRELESS COMMUNICATION

Topcon is the first manufacturer to offer Bluetooth wireless
technology for electronic totals&tions, This unique technology
eliminates the hassles of broken data collector cables, and

strugglingwithoffice cable connections.

TQPCQN FIELD CONTROLLERS

Topcon also offers two different field controller
options - our new FC-100for a compactsystem,
and the raw FC-2000 fora full keyboard option.

Both systems offera
fast 400MHz Intel

processor and a
bright fuH-colortouchsween running

die popular Windows C£* platform.

MODELS 30a2LW3003LW 3005LW 3Q07LW

taateAccuracy 2" 3" 5" 7*

Aigla testing wr Tff VP 5V1GT

hfettnd Absolute Reading.

CanpansaJoi Dual Dual Dual Snols

Lenglli 150mm

Objcliw Diameter 45mm (EOt.UOnin i

Magnification 30k

Image Emrt

Fiekiol Vis* tdag3Qmin

Mn. FocusDistance 1.3m<4.29l)

SttMMTO:

MKHwemenl flange* (1 pifemi 3.000m ROOOKl

MbeuiiitihiI AffiUiac/ Smmt^fin

Me&uiemenl lime Fine Appnxt2&ei1ntl3»c.i

Cease Apprcs 0.& Sec i]nil 2X> sec)

Trading AppBx0.3Secllnif2jsCvt

PEFLECIOFtESa

Maasuramail Range <Xcdi; While)

Long Mode: 120i)m<3,3»llt

HernialMole: 25cm >•&*[•

MejsuBmenl Actuac?^m tfOtnm

Maasuraniaii Accuracy 2&-12CCffl t5mm

Mejsuemenl lime Fine Appiosc 12 Sec ilnil3•aen .1

Coarse Appear Cl&Sec i)ntl 2.5 sat)

Tochinq AppioK03&cilnil233C)

Scram T'flK GfaphksLCD 160x64 Dcti vrilh badriighl

DisplayUnit Dual Dual Dual Single

OPERATING TIM - SINGLEBffTERr

Including EDM maajranenl 32 Hours

taglemearonflntonly 45 hours

Recta ije Time 1.3 Hours

Ballaryijpa MMH

VArefes. ConiKiton *ES, Bluetooth

Pan! Guida YES

Laser Plommel YES

LaserPointar tES

'fleighl Iw/nalfeiy) 11.4 lbs.

Waleiprod Prdecticn IP66

ismpeHluie Range -4b+122F



Appendix B: Control Points to Assess Reflectorless Total Station

Points A Location

Points B Location



Points C and Points D Location



Appendix C: Setting up the Reflectorless Total Station

welling the Instrument

Place the reflectorless total station on the mounting pod.

Center the bull's eye level using the three knuckle screws for finer adjustment. After

centering bull's eye, the user need to center line level by first using two knuckles

screws concurrently. Then turn the reflectorless total station 90 degrees, and use third

knuckles screw to finally center the line level.

reparing Data Collector

-eating new datafile

• Press MENU button followed by "Collect Data"

• Press "Job File" and type in Job File Name followed by ENTER button.



idding to Data File

• Press MENU and "Collect data"

• Press "Job File". Use arrows to select file. Press ENTER.

Obtaining BackSightfor TotalStation (in thisproject usedfor Reference Point)

• Enter OCC. PT# (Occupied point, normally numbered as 1)

• Enter OCC. ID (Occupied point ID, descriptive label for marker point)

• Enter INST HT, (Instrument Height) in meters. (For this project INST.HT = 1.415m)

• Press OCNEZ to accept default coordinate (0, 0, 0)

• Press ENTER

• Enter BS PT# (back Sight point)

• Enter BS ID (Back sight ID)

• Press 0 Set

• Aim total station at back sighting point and press MEAS

Obtaining Fore Sightfor Ttotal Station (in thisproject used to measure Observed Points)

• Enter Point# (Point number)

• Enter Point ID (target point description; in analysis let the Point ID to be OBI)

• Enter Target Height (set to 0)

• Press MEAS.

• Redo Step above with different Point# and Point ID (Let Point ED to be OB2 and so

on)



Appendix D: How to Transfer Data using Topcon Link

string on Topcon Link

In order to create newdevice properties the userneed to click File> Import from

Devices (as shown below).

Re Etft Wew Process Window Help

OpenHe,.. Ctri+O f.

Export to Device...

Convert Fie,.,

5Hft+P4 fi|

Page5etup...

ConfiguaHon.,, Ori-H=2 11

ieV,.\FYP TOPC0N\Z3feb.txt
2 C:V.AMyDoeuments\ffel ,txt

Exit

Click onLook in> Topcon Total Station menu at thebox left side (as figure below).

Click on Add New Station,

tfl'lmport from Device

Look in:

^flddl

# Topcon TotalSt. •*•

Desktop
3 Mji Computer

fj Mobile Device
££*] Topcon Receiv
«£- Topcon Digftal L

Close

Look in: JQ Desktop
| iuJFinalDissertation

Si FYP

rUfffl
§DfypFolder
Ilfilel

Create Station Menu willbe appeared. The menu consists of twomain parts which is

General andAdvance Sub-menu. Fill in the properties as figures next page. ClickOK

button once done.



'Create Station

General jAdvanced ]
Name jfeflectorlessTotal Station

Note

Port

Model

1C0M1

OK Cancel

'f^^iiM^^^^^M^^^&M^^^^^ii^^^^^^^^^^^^

General Advanced ]

Baud Hate :mmm r»3
Parity jNone • i

Data Bits f? j3

StopBits l-| i

z*

Protocol JAOyNAoT"
__j

Cancel ! **?• JOK

Click on newly added total station (Reflectorless Total Station), then the filel .txt filewill

be shown. Then in right boxchoose the folder "C\fyp" as destination where the file will

be stored.

iwf"''Import fromDevice

Look in j 2 reflectoiless ToU •* > $=•
_j™4

fc9 filel.txt

»

Close

Look m Ejfyp

tcScolleetionofdataj
pder"t""
f^tbljypdata
@fypi

»1 <• IB CIH



string on Reflectorless Total Station

le reflectorless total station also needed to be set up in order to establish a connection with PC

r data transferring. The instrument needs to be switched on first. The next procedure is as

How:

Press Menu > Parameters > RS-232 button and set the parameters as below:

Baud Rate: 9600

Parity: 8/none

Stop Bits: 1

ACK Mode: Standard

CRLF:ON

Rec-Type: A

After finished, press Menu > Memory Manager > Data Transfer > SSS

Press Menu > Comm Parameters > Check all (check whether the parameters same as
figure above. Change it ifnot similar)

Press Send data > Coordinate Data > File Name (Choose the file that need to be
transferred)

Meanwhile click » button in Topcon Link Menu as shown in figure below and followed
by pressing YES button on total station for completing the process. Click close button to
exit.

I*jf Import from Device

Looksr £ reflectorless Totc^j 4=1

H filel.txt

Close

Look ax. ^)fup

jldjxlledion ofdata
flUalert
fUltblJVpdata
(KM

«.j



le example of file.1 txt data is shownas figurebelow.

ji, o.oooo, o.oooo, o.0000, POD
2,0.OOOO,12.4900,Q.6650,REFPT
300,5.9160,21.2220,8.9890,OBl
400,20.8750,-3.9920,7.4420,082
500,-36.2570,-13.9190,8.9190,0B3
B



Appendix E: The Coordinates of Observed Points in Text File Format

late: 23 February 2006

[00,5.9170,21.2170,9.0080,061
L00,20.8780,-3.9930,7.4140,062

late: 24 February 2006

100,5.9180,21.2150,9.0060,OBI
L00,20.8810,-3.9910,7.4140,OB2

late: 25 February 2006

tOO,5.9200,21.2160,9.0040,081
L00,20.8810,-3.9920,7.4150,OB2

late: 26 February 2006

iOO,5.9200,21.2140,9.0060,OBI
100,20.8820,-3.9940,7.4210,062

late: 27 February 2006

100,5.9180,21.2150,9.0110,061
100,20.8810,-3.9920,7.4190,0B2

late: 28 February 2006

100,5.9200,21.2150,9.0080,OBI
100,20.8790,-3.9980,7.4200,OB2

late: 1 March 2006

iOO,5.8590,21.2310,9.0090,OBI
100,20.8950,-3.9350,7.4130,062

late: 2 March 2006

100,5.9170,21.2210,8.9910,OBI
100,20.8800,-3.9930,7.4200,062

late: 3 March 2006

S00,5.9160,21.2220,8.9890,OBl
100,20.8750,-3.9920,7.4420,0B2

late: 4 March 2006

J00,5.9170,21.2210,8.9960,OBl
100,20.8840,-3.9900,7.4140,062



late: 5 March 2006

IOO,5.9110,21.2200,9.0040,OBl
•00,20.8830,-3.9890,7.4090,OB2

: The date will not appear in the text file. It is shown to differentiate each data.



Appendix F: The Coding of System

l) Main Page

'rivate Sub CommandlClickQ

main.Hide

PO11.Show

!nd Sub

'rivate Sub Command2i_Click()

main.Hide

POI2.Show

:nd Sub

i) System Interface for OBl

'rivate Sub mnuAbout_Click{)
bout.Show

!nd Sub

rivate Sub mnuAnalyze_Click()
Hm X1 As Double

Hm Y1 As Double

Hm Z1 As Double
»im mov_dist As Double
>im sResultl As String
iimsResult2 As String
im sSound As String

nding the difference between the coordinate taken and the reference coordinate
tDiffxlText = Round(Abs(Val(txtRefx.Text) - Val(txtCoordx1 Text)), 3)
tDiffyl Text =Round(Abs(Val(txtRefy.Text) -ValjtxtCoordyl Text)), 3)
tDiffzl Text = Round(Abs(Val(txtRefz.Text) - Val(txtCoordz1 Text)), 3)

d verily the date is keyed in
txtDatel ="" Then

MsgBox "Please enter the date", vbOKOnly, "Attention"
Ise

'finding the movement distance
•movement distance = square root of [(X1 • X1) + (Y1 * Y1) + (Z1 *Z1)]
X1 = txtDiffxl

Y1 = txtDiffyl
Z1 = txtDiffzl

mov_dist = Sqr((X1 * X1) + (Y1 * Y1) + (Z1 * Z1))
txtMaxDiffl Text = Round(mov_dist, 3)

sResultl = "OK"

sResult2 = "DANGER!"

'Path of sound's file. Located in "C:\fyp\alert.wav"
sSound = "C:\fyp\alert.wav"

'to evaluate whether the result is "OK" or "DANGER"

If (Val(txtMaxDiff1 Text) < ValftxtAllowableText)) Then
for "OK" result

MsgBox sResultl, vbOKOnly, "Result"
txtResultlText = sResultl

Else

'for "DANGER" result

'produce sound
ActiveMovieControl.RunVideoContent sSound



MsgBox sResuit2, vbOKOnly, "Result"
txtResultLText = sResult2

End If

End If

Model .Recordset.Save

nnuNew.Enabled = True

!nd Sub

'rivate Sub mnuBack_Ctick()
'OIlHide

lain .Show

ind Sub

•rivate Sub mnuExit_Click()
)im reply As Integer

3ply= MsgBoxfAre you sure want to exit?", vbYesNo, "Attention")
: reply = vbYes Then

End

ilself reply = vbNo Then
PO11.Show

ind If

to exit from the application
End

!nd Sub

'rivate Sub mnuLoad__Click()

ModelRecordsetAddNew

»im intNULL As Integer, dblX As Double, dblY As Double,dbIZAs Double,strPoint As String, intcountAs Integer

)pen "c:\fyp\file1 .txt" For Input As #1
)o While Not EOF{1)
itcount = 0

to While intcount < 5

iput #1, intNULL, dblY, dblX, dbIZ, strPoint
strPoint = "OB1" Then

:tCoordxlText = dblX

;tCoordy1 Text = dblY
:tCoordz1Text = dblZ

ndlf

itcount = intcount + 1

oop

lose #1

idodd .Recordset.Save

ndSub

rivate Sub mnuNew_Click()

Adodd.Recordset.AddNew
mnuNew.Enabled = False

'to display date automatically (without key in)
'txtDate1Text=Date$

ndSub

rivate Sub mnuReset_Click()
tDatel =""

tCoordxl =""

tCoordyl =""
tCoordzl =""

tDiffxl =""

tDiffyl =""



xtDiffzl =""

xtMaxDiffl =""

xtResultl =""

End Sub

^rivate Sub mnuView_Click{)

>OI1.Hide

lb_POI1.Show

End Sub

:) System Interface for OB2

'rivate Sub mnuAbout_Click()
ibout.Show

ind Sub

'rivate Sub mnuAnalyze_Click()
)im X1 As Double

Jim Y1 As Double

Jim Z1 As Double

Jim mov_dist As Double
Jim sResultl As String
Jim sResult2 As String
Jim sSound As String

inding the difference between the coordinate taken and the reference coordinate
<tDiffx1 Text = Round(Abs(Val(txtRefx.Text) - Val(txtCoordx1 Text)), 3)
<tDiffy1 Text = Round(Abs(Val(txtRefy.Text)-Val(txtCoordy1Text)), 3)
<tDiffzLText = Round(Abs{Val(txtRefz.Text)-Val(txtCoordzlText)), 3)

o verify the date is keyed in
:txtDate1 =""Then

MsgBox "Please enter the date", vbOKOnly, "Attention"
:!se

'finding the movement distance
'movement distance = square root of [(X1 * X1) + (Y1 * Y1) + (Z1 * Z1)]
X1 = txtDiffxl

Y1 = txtDiffyl
Z1 = txtDiffzl

mov_dist = Sqr((X1 * X1) + (Y1 * Y1) + (Z1 * Z1))
txtMaxDifflText = Round (mov_dist, 3)

sResultl = "OK"

sResult2 = "DANGER!"

'Path of sound's file. Located in "C:\fyp\alertwav"
sSound = "C:\fyp\alert.wav"

'to evaluate whether the result is "OK" or "DANGER"
If (Val(txtMaxDifflText) < Val(txtAllowable.Text)) Then

'for "OK" result

MsgBox sResultl, vbOKOnly, "Result"
txtResultLText = sResultl

Else

'for "DANGER" result

'produce sound
ActiveMovieControl.RunVideoContent sSound
MsgBox sResult2, vbOKOnly, "Result"
txtResultLText = sResult2

End If

ndlf

dodd .Recordset.Save

muNew.Enabled = True



End Sub

'rivate Sub mnuBack_Click()
>OI2.Hide

nain.Show

End Sub

Jrivate Sub mnuExit_Click()
Dim reply As Integer

epiy = MsgBox{"Are you sure want to exit?", vbYesNo, "Attention")
f reply = vbYes Then

End

Elself reply = vbNo Then
POI2.Show

End If

to exit from the application
End

End Sub

3rivate Sub mnuLoad_Click()

Adodd .RecordseLAddNew

Dim intNULL As Integer, dblX As Double,dblY As Double, dbIZAs Double, strPoint As String, intcountAs Integer

Dpen "c:\fyp\file1.txt" For InputAs #1
Do While Not EOF(1)
ntcount - 0

Do While intcount <5

nput #1. intNULL, dblY, dblX, dbIZ, strPoint
f strPoint = "OB2" Then

ixtCoordxLText = dblX

xtCoordyl Text = dblY
xtCoordzLText = dblZ

End If
ntcount = intcount + 1

_oop

Dlose #1

End Sub

^rivate Sub mnuNew_Click()
Adodd .Recordset.Add New

mnuNew.Enabled = False

'to display date automatically (without key in)
'txtDate1.Text = Date$

End Sub

Private Sub mnuReset_Click()
SxtDatel =""
txtCoordxl =""

txtCoordyl =""
txtCoordzl =""

txtDiffxl =""

txtDiffyl =""
txtDiffzl =""

txtMaxDiffl =""

txtResultl =""

End Sub

Private Sub mnuView_Click()

POI2.Hide

db POl2.Show



End Sub

1) To Provide Sound when Critical Condition

)ption Explicit
option Base 0
Dption Compare Text

'rivate m_dblRate As Double 'Rate in Frames Per Second
'rivate m_bstrFileName As String 'Loaded Filename
'rivate m_dbl RunLength As Double 'Duration in seconds
'rivate m_dblStartPosition As Double 'Start position in seconds
'ublic mJjoolVideoRunning As Boolean 'Flag used to trigger clock
'rivate dblPosition As Double ' Current Play position
'rivate m_objBasicAudio As IBasicAudio 'Basic Audio Object
'rivate m_objBasicVideo As IBasicVideo "Basic Video Object
'rivate m_obj MediaEvent As IMediaEvent 'MediaEvent Object
'rivate m_objVideoWindow As IVideoWindow 'VideoWindow Object
'rivate m_objMediaControl As IMediaControl 'MediaControl Object
'rivate m_obj MediaPosition As IMediaPosition 'MediaPosition Object

'Main Video/Audio Loading codes
'method to toad video/audio file
Sub RunVideoContent(ByVal path As String, Optional ByVal DontMaintainRatio As Boolean, Optional ByVat FullScreen As

Joolean)

Dim nCount As Long
Dim sScale As Double

Dim topMod As Long
On Local Error GoTo ErrLine

"clean up memory (in case a file was previously opened)
UnloadActiveMovieContro!

'Setting file to object
m_bstrFileName = path

'Instantiate a filter graph for the requested file format.
Set m_obj MediaControl = New FilgraphManager
Callm_objMediaControl.RenderFile(m_bstrFileName)

'Setup the IBasicAudio object (this is equivalent to calling Querylnterface()
'on IFitterGraphManager).
'Initialize the volume to the maximum value.

'Some filter graphs don't render audio
'In this sample, skip setting volume property
Set m_objBasicAudio = m_objMediaControl
m_pbjBasicAudio.Volume = 0
m_objBasicAudio.Balance = 0

'Setup the IMediaEvent object (PLAY video/audio).
Set m_obj MediaEvent = m_objMediaControl

'set the playback rate given the desired optional
m_pbj MediaPosition. Rate - 1 ' Normal play rate
' NOTE: you can set values like 1.5 for 150% speed, pretty nice

'Use user-established playback rate
m_dblRate - m_objMediaPosition.Rate

'Reset start position to 0
m_dblStartPosition = 0

'Play the file
PlayActiveMovie

Exit Sub

ErrLine:

Err.Ciear

Resume Next

End Sub



I*******************************************

1**** Unloading Control from memory ****
i*******************************************

Sub UnloadActiveMovieControK)
On Local Error GoTo ErrLine

'stop playback
m_boo!VideoRunning = False
DoEvents

'cleanup media control
If Not m_objMediaControl Is NothingThen

m_obj MediaControl.Stop
End If

'clean-up & dereference
IfNot m_objBasicAudio Is Nothing Then Set m_objBasicAudio = Nothing
If Notm_objBasicVideo Is Nothing Then Set m_objBasicVideo = Nothing
If Notm_objMediaControl Is Nothing Then Set m_objMediaControl = Nothing
IfNot m_objVideoWindow Is Nothing Then Set m_objVideoWindow = Nothing
IfNot m_objMediaPosition Is Nothing Then Set m_objMediaPosition = Nothing
Exit Sub

ErrLine:

Err.Clear

End Sub

• *************************************

"**** Control Methods (PLAY) ****
i*************************************

Sub PlayActiveMovie()
On Local Error GoTo errHandle

'Assign specified starting position dependent on state
If CLng(m_objMediaPosition.CurrentPosition) < CLng(m_dblStartPosition) Then

m_objMediaPosition.CurrentPosition = m_dblStartPosition
ElselfCLng(m_objMediaPosition.CurrentPosition) = CLng(m_dblRunLength) Then

rrtpbjMediaPosition .CurrentPosition = m_dblStartPosition
End If

m_boolVideoRunning =True
Call m_objMediaCont.rol.Run

Exit Sub

errHandle:

Err.Clear

Resume Next

'logerror
End Sub


